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EA TOOLS & MATERIALS END USER LICENSE
Electronic Arts Inc, and its subsidiaries, affiliates and licensors (collectively, “EA”) grants you a non- transferable 
non-exclusive license to download and/or install and use one copy of the software tool (“Tool”) and/or materials 
(“Materials”) (collectively the “Tools & Materials”) solely for your personal noncommercial use in connection with EA’s 
products, in accordance with the terms below.

EA owns all of the rights, title and interest in the Tools & Materials. You may not alter any of EA’s trademarks or 
logos, or alter or remove any of EA’s trademark or copyright notices included in or with the Tools & Materials or EA’s 
products. Your right to use Tools & Materials is limited to the license grant above, and you may not otherwise copy, 
display, distribute, perform, publish, modify, create works from, or use any of the Tools & Materials.  Without limiting 
the preceding sentence, you may not modify, reverse engineer, disassemble, license, transfer, distribute, create works 
from, or sell the Tool, or use the Tools & Materials to further any commercial purpose.  Without limiting the foregoing, 
you may not use the Tools & Materials to promote another product or business, or on any site that operates or promotes 
a server emulator.

You may include materials created with the Tools & Materials on your personal noncommercial website for the 
noncommercial benefit of the fan community for EA’s products and provided that if you do so, you must also post the 
following notice on your site on the same web page(s) where those materials are located:  “This site is not endorsed by 
or affiliated with Electronic Arts, or its licensors.  Trademarks are the property of their respective owners.  Game content 
and materials copyright Electronic Arts Inc. and its licensors.  All Rights Reserved.”  You will not represent that your site 
is endorsed or approved by or affiliated with EA or our licensors or that any other content on your site is endorsed or 
approved by or affiliated with EA or our licensors.

THESE TOOLS & MATERIALS ARE PROVIDED “AS IS” WITHOUT ANY WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED.  
EA SPECIFICALLY DISCLAIMS ANY WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY AND 
NONINFRINGEMENT.

ANY USE YOU CHOOSE TO MAKE OF THESE TOOLS & MATERIALS IS UNDERTAKEN BY YOU ENTIRELY AT YOUR OWN 
RISK.  EA DOES NOT WARRANT THAT THESE TOOLS & MATERIALS WILL NOT CAUSE DAMAGE TO YOUR COMPUTER 
SYSTEM, NETWORK, SOFTWARE OR OTHER TECHNOLOGY.

EA WILL NOT PROVIDE SUPPORT FOR THESE TOOLS & MATERIALS.  PLEASE DO NOT CALL OR SEND EMAIL TO 
EA CUSTOMER SUPPORT REGARDING THESE TOOLS & MATERIALS, AS EA WILL NOT BE ABLE TO ANSWER THESE 
INQUIRIES.

IN NO EVENT SHALL EA BE LIABLE FOR ANY DIRECT, CONSEQUENTIAL, INCIDENTAL, SPECIAL, PUNITIVE OR OTHER 
DAMAGES WHATSOEVER, ARISING OUT OF OR RELATED TO THIS LICENSE EVEN IF EA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

EA RESERVES THE RIGHT TO DISCONTINUE THE AVAILABILITY OF THESE TOOLS & MATERIALS, OR MODIFY THEM, AT 
ANY TIME, WITHOUT OBLIGATION TO ANYONE.

At EA’s request, you agree to defend, indemnify and hold harmless EA from all liabilities, claims and expenses, including 
attorneys’ fees, arising from any breach of this License by you and/or your use or misuse of the Tools & Materials.

EA may make the Tools & Materials available at its site(s) located in the United States and/or Canada and/or the 
European Union.  You are solely responsible for knowing and complying with all federal, state, and local laws that may 
apply to your use of Tools & Materials in your own locale. By downloading any Tools & Materials, you warrant that you 
are not located in any country, or exporting the Tools & Materials to any person or place, to which the United States 
and/or Canada and/or European Union or its member countries has embargoed goods.

EA may revoke or terminate this license at any time, for any reason or no reason, in its sole discretion.  Upon 
termination, you must destroy or return to EA all Tools & Materials.  This License is governed by United States Copyright 
and California law (without regard to conflicts of law), and is the entire agreement between EA and you regarding the 
Tools & Materials.
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KEy COMMANDS
Windows Hotkeys
General

New world Ctrl-N
Open world Ctrl-O
Save world Ctrl-S
Undo/redo action Ctrl-Z/Ctrl-Y

Camera Controls—Mouse

Camera Controls—Keyboard
Move forward/backward/ left/right Up/Down/Left/Right arrows
Move up/down Q/F
Zoom in/out Num +/Num - or W/S

note: You can change the direction of the camera, if you like. Under the View menu, choose 
CAMERA SETTINGS > CAMERA CONTROL. You can invert both the horizontal and vertical rotation.

Tools Hotkeys
General

Exit current tool Esc
Delete selected object Del

Object Tool
Clone selected lot Shift
Snap rotation (if object in rotation mode) Shift

Edit Road Tool
Toggle road object selection Ctrl
Disconnect connected objects Shift

Rotate Road Tool
Snap rotation to the nearest 15 degrees Shift

Move Lot Tool
Snap rotation Shift

Paint Terrain Tool
Navigation mode Alt
Paint in straight lines only Shift

note: Navigation mode is a great way to keep from accidentally painting or sculpting while 
you’re navigating around the render panel.

Terrain Brush Tool
Navigation mode Alt
Increase/Decrease brush size Ctrl-PgUp/Ctrl-PgDwn

Rotate (push)/Zoom (scroll) Move

INSTALLING THE TOOL
To install The Sims 3 Create a World Tool—Beta:

Go to 1. The Sims 3 Community site at www.thesims3.com. 
From the Games pull-down menu at the top of the page, choose 2. The Sims 3 Create a World. Your 
browser brings up The Sims 3 Create a World Tool—Beta page. 
Click the DOWNLOAD NOW button and follow the on-screen instructions. 3. 

note: You must have registered a copy of The Sims 3, The Sims 3 Collector’s Edition, or The Sims 3 
World Adventures to download the tool.

STARTING THE TOOL
To start the Tool:
Games on Windows Vista™ are located in the Start > Games menu and on earlier versions of 
Windows™ in the Start > Programs (or All Programs) menu.
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Toolbars WORLDS AT yOUR FINGERTIPS!
If you thought you were godlike playing The Sims 3, wait until you try out this tool! The Sims 3 Create 
a World Tool—Beta is a powerful tool that lets you create and customize your very own towns and it’s 
the same tool (with a few modifications) that our World Building Team uses to create the towns that 
you get with the base game or in the expansion pack.
The windows in The Sims 3 Create a World Tool—Beta are modular, so you can customize the layout 
of the tool while you work. However, the windows revert to their defaults when you restart the tool.
This tool is also expandable! You will get more items to work with, every time we release an expansion 
pack, provided you own and install the expansion pack.

CREATE NEW WORLDS
To create a new world:

From the File menu, choose NEW WORLD. The New World Options pop up appears.1. 
Click the browse button to choose a terrain image file.2. 
The terrain image file is a height map that determines the basic size and shape of the terrain. ♦

Then choose a desert or lush climate (which determines the default available terrain paints in your 3. 
world), and set the maximum map height (Each file in the Height Maps directory has a number in 
the filename. Set your maximum height map to this number). Click OK.

poWer user tIp: You can import and export different height maps to create/edit your 
terrains with external programs such as Adobe Photoshop or World Machine, etc. The height 
map files must be a 16 bit grayscale .PNG image and be one of the following sizes: 256x256, 
512x512, 1024x1024, or 2048x2048. 

Rotate World 
Object

Edit in Game 
(p. 13)

Snap to 
Grid mode

Undo         RedoSelect Move

Grading 
Road tool 

(p. 11)

Road Placement 
and Editing tools 

(p. 10)

Cluster 
Trees

Uncluster 
Trees

Conform 
(p. 13)

Flatten 
(p. 13)

Add a 
New Lot 
(p. 12)

Clone  
(p. 13)

Import Height 
Map (p. 5)

Export 
Height 
Map

Paint (and  
sculpt) Terrain 

(p. 6)

Adjust  
Sea Level 

(p. 9)
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TERRAIN EDITING
Whether you want to add mountains or valleys, grass or asphalt, the terrain tools let you shape—and 
color—your world.

 Sculpt Terrain
Raise mountains, carve out valleys, chisel cliffs, and more.
To sculpt terrain:

Click the TERRAIN tab and then choose the Terrain Editing Tools option.1. 
On the right side of the screen, click the SCULPT button.2. 
Choose a brush type that corresponds to the shaping that you want to do.3. 
Adjust the parameters of the brush, as needed.4. 
Move the cursor over the spot that you want to sculpt and click and hold the mouse button while 5. 
moving the brush over the terrain. 

Sculpting Brush Parameters
Size Determine the amount of area affected by your action.
Strength Adjust how the selected action affects the area. The greater the strength, 

the more magnified the action.
Falloff The greater the falloff, the more the effect/action tapers toward the edges 

of the brush.

Show Unroutable Terrain
This options shows you the steep areas of terrain that should be painted with Sims Non-Routable paint 
(see Routing on p. 8). Note that while it also recommends that you paint water unroutable; you do not 
need to do so.

 Paint Terrain
Add dirt, sand, flagstone, grass, concrete, and more! You should only add up to eight different terrain 
paints per chunk (section) of world to keep your world running smoothly. To see the sections of the 
world, go to View > Show Chunk Boundaries. You can change the distance of how many sections you 
see rendered in high level of detail (LOD) by going to View > Camera Settings and changing the LOD 
Transition Distance.
To paint your terrain:

The paint section of the Terrain Editing tool window contains a few defaults based on the type 1. 
of terrain you chose when you started your world. If you want to add another paint, click ADD to 
open the pop-up window and choose a specific terrain texture by clicking the browse button and 
selecting the desired terrain texture (i.e., sand, dirt, concrete, etc.).
Next set the Terrain Type from the pull-down menu. This setting determines what kind of sound 2. 
effects are produced when Sims walk on the selected terrain.

poWer user tIp: You can also create your own terrain paints! Just create a .tga or .dds 
file where the image size is a power of two, with a maximum size of 1024 x 1024 pixels with 
a resolution of 72 pixels per inch. Be sure not to reuse the same name for multiple textures as 
The Sims 3 Create a World Tool—Beta will only recognize one of them.

In addition to changing the size and falloff of your brush parameters when painting terrain, you can 
also adjust:
Auto Paint Select terrain paints to automatically paint different heights. The terrain 

Auto Paint feature uses the base color (the default terrain layer) and 
the next one (Default 2 terrain layer) to automatically paint the terrain 
according to height. The taller height gets painted with the Default 2 
terrain texture.

Individual Layer Mode Paint according to the hierarchy of the paints in your window. Paints that 
are farther down the list are added over the top of paints closer to the top. 
Under this mode, you can also set the color level. If set to 0, you’re erasing 
the selected color. At 255, it uses the full strength of that color. When set 
to any of the numbers in between 0-255, it blends the terrain paint with 
whatever the paint is underneath it and the selected paint color. You get 
different results depending on the alpha channel of the terrain paint.

Visualize Layer Shows where the currently selected terrain paint layer exists in the render 
panel, but not the color itself. When selected, you can use it to delete the 
terrain paint on the current layer using the terrain brush when this box is 
checked. The default terrain layer always appears over the entire map. 

Shape Choose a square or circular brush shape.
Opacity The higher this is set, the less you can see through the paint. 
Routing Opacity Shows or hides the areas where Sims and/or the camera cannot route.
That arrow under Brush Parameters saves your current brush settings to the window above it that says 
Brushes and you can save a bunch of them to use later.

poWer user tIp: If you later decide that you don’t really like how one of your terrain 
paints looks, you can choose a new file to replace the current file (which changes all instances 
of the old texture in your world). You can also right-click it in the Terrain Painting Tools Layer 
window and choose DELETE. All instances of that paint are also deleted in your world.

poWer user tIp: You can import and export terrain paint layers. This is useful for 
painting a grayscale image in a graphics illustration program and then importing it back into 
your world. To import/export a terrain paint layer, right-click the terrain paint in the Terrain 
Paint Layers window and choose either IMPORT or EXPORT. To visualize what your export of 
a particular layer will look like, click the Visualize Layer checkbox.
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Routing
Routing is a way to limit where Sims can go (walking, jogging, etc.) and where the camera can pan. It 
works just like the Terrain Painting Tools.

Sims
You can determine where Sims can go and where they can’t within your world. You may want to 
consider preventing Sims from routing to any place that they might get stuck (such as very densely 
forested areas), or areas where it would look strange for Sims to route (such as steep hills or 
mountains).

Camera
You may want to keep the camera from routing to places where you don’t want certain things to show 
(such as the edge of your world). Be careful not to create any places where the camera can get stuck 
when playing the game.

       
note: You cannot set routing within lots.

You can change shape and size of the routing brush for both Sims and the camera. ♦

Masks
Add masks to your world to prevent painting and sculpting within the masked area. It works just like 
the terrain painting tool, just paint the area that you want to mask.

Sea Level
Is your sea too far inland and covering way too much land or is your world far too dry? This tool lets 
you set how high—or low— the sea level is.
To adjust the sea level, click the SEA LEVEL button and then click a spot on your map that you want 
to sea to stop at. Any areas below that level in your world will then be underwater.

     

The blue area 
shows where  

Sims cannot route.

The yellow area 
shows where the 
camera cannot 
route.

This screen 
depicts a  
good use  

of camera 
non-routing.

This screen 
illustrates a 
bad example  
of camera  
non-routing 
paint.

The area shown 
is red is masked 
and cannot be 
modified.
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ROADS AND SIDEWALKS
Roads and sidewalks connect your world and its Sims. Without roads, your Sims cannot use cars, 
bicycles, or scooters. You can create roads and sidewalks of any imaginable shape or grade.

To add a road or sidewalk:
Click ROADS and the Road Tool window opens on your map.1. 
Click PLACE ROAD (or PLACE SIDEWALK) and then position your mouse and click where you want 2. 
to start drawing your road. This anchors your starting point.
Drag your mouse out to the next point in your road and then click. You can extend again from that 3. 
point too. The more extensions you have, the more you can manipulate.

poWer user tIp: If you hold down the left-mouse button while dragging out the road, you 
can alter the curve of the road while you’re placing it. Release the mouse button to create an 
anchor point, drag out the road to the next point, then click to set the road.

To move a road (or sidewalk), click the Move World Object tool then click or drag the dark blue box 
to reposition and stretch the road. You can also click and drag the light blue boxes to change the curve 
of the road.

To add an intersection:
Click ROADS and the Road Tool window opens on your map.1. 
Click PLACE ROAD INTERSECTION (or PLACE SIDEWALK INTERSECTION).2. 
Use the Move World Object tool to position the intersection close to the end of the road (or 3. 
sidewalk) that you want it to connect to. You know it has connected when it “snaps” into place. 
This creates crosswalk lines on your road.

note: You can only connect roads with other roads or road intersections and you can only 
connect single sidewalks to other single sidewalks and sidewalk intersections. You cannot connect 
a road to a single sidewalk or sidewalk intersection.

note: You should place your intersections while placing your roads. You cannot add an 
intersection in the middle of an already existing road. The easiest way to do this is to leave a gap in 
the road where you want to place an intersection, finish placing the road(s), and then go back and 
place intersections in the gaps. You can also delete a section of road and place an intersection in 
the empty spot and then reconnect the roads.

note: Beware, if any of your roads are unconnected, Sims will get out of their vehicle and walk 
to the next road, then get back in their vehicle.

Grading your Roads
If your roads traverse rough countryside (including mountains), you may want to grade them. You can 
smooth them, limit the road grade, or flatten the road, each of which are explained a bit more below.
Smooth Make the road smoother over rough terrain.
Limit Road Grade Limit the steepness of your road by setting the degrees in the Grade Limit 

box.
Flatten Flattens the road to the height where you click.
Speed/Quality Slider Render your changes quickly, but not as precisely, or more slowly but with 

more precise results.
Application Make changes to a single piece of road or to all the connected roads. 

Applying changes to all connected roads generally ensures that your roads 
are more uniform.

Road Edge Parameter Determine how your road interacts with adjacent terrain. Width is how far 
out from the road the changes are applied. You can also choose whether it 
smoothes adjacent terrain or not.

To apply these settings, change the desired parameters and then click the part of the road that you 
want to change.

poWer user tIp: You can edit the texture of the roads /sidewalks to match your world by 
creating road textures in an external program.

Click and hold 
a light blue box 

to change the 
curvature.

Click and hold the 
dark blue box to 
extend the road.



12 13

LOTS
You’ll need to place lots for your world to be playable. You can place commercial and residential lots.

Adding New Lots
You can create lots of any size (up to 64 x 64) anywhere in the world. You must use the Edit in Game 
feature to build on the lots (see p. 13). 

note: Consider turning on Snap to Grid mode when you’re placing lots. It helps to align your 
roads and also to align neighborhoods so that they seem more cohesive and planned.

To add a new lot:
Before you can add lots to your world, you must create a new layer. Right-click WORLD in the 1. 
World Layers window and then choose ADD LAYER.

note: Layers are great for organizing your world—if you have a lot of objects in your world, it’s 
much easier to find specific objects if they’re in different layers. For example, if you want to select 
all of the trees (or lots or roads) to delete them and they are all on one layer, you can simply delete 
the layer. It also helps with tree clustering. Trees cluster per type and per layer. If you have two 
of the same type of trees on two different layers, they will be clustered in two separate clusters, 
which isn’t as good for performance as having them all on one layer, clustered together.

Click the Add a New Lot button.2. 
Click a spot in the world to begin drawing the first side of your lot and then click again when the 3. 
side is the length that you want it.
Drag the mouse out to establish the total size of the lot and then click again. You can see the size 4. 
of the lot as your draw it at the bottom right of the screen. The Lot Information pop-up appears.
If the lines turn red, your lot cannot be drawn in that location. Try making it smaller or starting it  ♦
somewhere else. Press ESC and click the Add a New Lot Button to start drawing your lot again.
At the pop-up, set the type of lot, and choose the Lot Sub-Type, for example a Fishing Spot, Beach, 5. 
or Graveyard. Later you’ll place certain objects when you edit the lot in-game (see p. 13) so that 
your Sims can engage in the appropriate activities. 

note: For information on which objects certain lots types require, see p. 14.

Set the Additional Property Value (this is added to the cost of the lot, so you might add value if 6. 
it’s in a great location or subtract value if it isn’t) and the Beautiful Vista Buff (this increases the 
likelihood that Sims will get a Beautiful Vista moodlet when on the lot).
Name your lot (you must have all of your lots named to save your world).7. 

note: You can alter most of the info that you enter for lots in the Property Browser window.

The following tools are useful for making adjustments to a lot.
Clone Make a copy of this lot. You can only clone empty, unmodified lots.
Flatten Level a graded, hilly or mountainous lot to the elevation on which you click.
Conform Edges This allows you to ensure that your edges are compatible with the 

elevations surrounding them. This action fixes “holes” in your terrain that 
are created when you move lots around.

note: If you modify the terrain under an empty lot, select the Move Tool and hold ALT while 
moving the lot slightly. This conforms the lot terrain to the world terrain.

note: To find a lot or object that you’ve placed on the world terrain in your layers panel, select 
the object and click the spacebar. This takes you to the object name in the Layers window. You 
can also right-click an object name in the Layers window and select FIND IN RENDER PANEL and it 
selects that object for you and moves the camera there.

Edit In Game
Build and Buy modes are nearly the same as in The Sims 3, with a couple of differences. The camera 
controls are the controls from The Sims 3 Create a World Tool—Beta, you cannot enter Live Mode, and 
you can move from lot to lot. You must save your game before you exit Edit in Game in order for your 
changes to show up in The Sims 3 Create a World Tool—Beta.
To edit a lot in-game:

After your lot is created, click the Edit in Game icon. 1. 
Once the game window appears, click the Options icon and then choose EDIT TOWN. The screen 2. 
refreshes. Choose one of the lot icons to edit that lot.
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OBjECTS, EFFECTS, AND SPAWNERS
Once you’ve got your world sculpted and painted, you can start placing trees, other plants, and special 
effects.

Placing and Manipulating Objects
To place an object:

Click the desired menu option in the Metadeta window (Spawners, Environment, Trees, or Effects).1. 
From the list, 2. double-click the object that you want to place.
Move your cursor to the spot that you want to place your object and click. Click and hold to rotate 3. 
the object before it’s locked into place. You can keep clicking and placing as many of these objects 
as you like.
When you’re done placing that type of object, press 4. ESC to clear your cursor.

To move an object you’re already placed:
Click the Move World Object icon and then select the object that you want to adjust (make sure to 1. 
release the mouse button after you select it).
Click the object itself to move it freeform, along the ground. Click the red, blue, or green line to 2. 
move it only along that axis. When you select a specific axis, it turns yellow.

poWer user tIp: To snap an object to the surface, CTRL-click the green line  
(the manipulator handle) while you are in the Move Tool.

note: You can move the object vertically as well, making it possible to sink things into the 
ground or float them in the sky!

note: You can also change the location of an object by changing its number in the Property 
Browser window.

note: You can also move an object by clicking a central point on the object and holding the 
mouse button down while moving the mouse around.

To rotate an object you’ve already placed:
Click the Rotate World Object icon and then select the object that you want to adjust (make sure to 1. 
release the mouse button after you select it).
Click the object itself or the green manipulator handle around it to rotate.2. 

To delete an object you’ve already placed, click the Select World Object icon, select the object and 
press Del.

Effects
Clouds, birds, insects, and more—place a variety of effects to bring your world to life! Place them in 
the same way that you place objects.

note: You cannot always see the, er, effects of your effects until you view your created world 
in The Sims 3. But some effects, after you have seen them in-game will show up in The Sims 3 
Create a World Tool—Beta.

When or whether an effect appears depends on the effect. Some effects, like the rainbow, only have 
a percentage chance of occurring on sunny days during daylight hours. Others, like the spawners, 
are tuned differently by the designers, some, like birds are totally random, and some, like the hot air 
balloon and the boats, are persistent.

Spawners
Spawners will sporadically create instances of collectible items in your game, like fish, gems, rocks, 
and more. Place them in the same way that you place objects and effects.

note: For information on what each spawner places, see p. 19.

SHARING
Share your worlds on The Sims 3 Community Exchange so other players can play them in their games!
To share a world:

First add a world description and an icon by right-clicking the topmost layer of your world and 1. 
choosing ADD/EDIT DESCRIPTION. Your icon image must be a .png file that is 256x256.
Save your world.2. 
Under the File menu, choose SELECT WORLD FOR EXPORT and then browse to the world file that 3. 
you want to export and choose OPEN.
Finally, upload it to the Exchange (via 4. The Sims 3 Launcher) as you would a lot or family.

USING yOUR WORLD IN-GAME
Now that you’ve created a masterpiece, it’s time to let your Sims reap its rewards in-game.
To play the world you’ve created:

Follow steps 1-3 above.1. 
Double–click the .Sims3Pack file.2. Click the blue 

line to move the 
selected object  

left/right.

Click the green 
line to move the 
selected object 
up/down.

Click the red 
line to move the 
object backwards/
forwards.
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HINTS AND TIPS
General

Use the Rotatable Grid! It makes it easier to line up things, and aligning things to the grid makes  ♦
routing more realistic in-game.
Use different layers to help organize the world objects/lots/etc. ♦

View your world in wireframe to place objects more precisely. ♦

Bodies of water are by default stocked with ocean fish. If you create a river, populate it with fresh  ♦
water fish by using spawners.

Lot Location and Routing
You cannot put a larger lot onto a smaller lot. Stick with a few standard lot sizes to make sharing  ♦
and moving more convenient. Keep this in mind for community lots as well as residential lots.
Lots should have one side flush against the road to enable smoother smoother routing when Sims  ♦
go from their house to the road.
The footprints of all interactive objects should be completely on the lot. ♦

Non-routable areas in the world should look non-routable. Routable areas should look clearly  ♦
routable. If you have a tall mountain that has foothills that you don’t want your Sims to route over, 
add a fence or a strand of trees along the edge of your non-routable paint so it looks like Sims 
wouldn’t be able to go there.
All porches should have at least double-wide stairs leading up to them, so that multiple Sims can  ♦
use them at once.
Porches should have enough space for at least two Sims to socialize. If possible, allow enough  ♦
space for more than two Sims to accommodate party guests and welcome wagons (usually three 
Sims). Two socializing Sims require a 1x2 tile area that is not blocked by stair or door routing 
footprints, or wall-mounted lamps. 
Roads and sidewalks should always be terminated with an intersection piece. If they are not, Sims  ♦
cannot make U-turns in their cars to turn around on dead end roads.
Use bridges (made of foundations) sparingly as Sims prefer to walk around them rather than over  ♦
them (because they exist in a different “room”) and they do not look good with walls down or walls 
cutaway if the rest of your lot is not also on a foundation.
Game objects placed on the world layer should never hang over the edge a lot. Sims won’t know  ♦
that they’re there and may walk right through them. Keep world-placed game objects at least one 
tile away from the outside of the lot.
Fences, especially thick ones, that sit at the edge of the lot are likely to be clipped through by Sims.  ♦
Consider putting fences at least one tile inside the perimeter of the lot.
Many objects and rabbitholes are large. Make sure that the lots that you create are large enough  ♦
for the objects/buildings that you want to place on them.

Performance
Following these tips help ensures that the worlds you make run smoothly on most machines.

Clustering trees improves performance, especially if you have a lot of trees in your world. ♦

Limit plants to only four species and a total of 30 plants per lot. ♦

Use up to four terrain paints per lot.  ♦

Use no more than eight terrain paints in the world per 256 x 256 chunk. ♦

Be conservative with double-walls  and making pillars with the wall tool. They create small rooms  ♦
that the routing system has to calculate.
To make lots look better on lower end computers, space lots further apart so that only one high  ♦
detail lot is visible at a time.

Gameplay and Aesthetics
Place spawners near interesting features in your world to enhance your overall story. ♦

Organize your town into unique little neighborhoods to add realism and depth to your world. ♦

Keep neighborhood clusters aligned to the same grid to make them look more cohesive. ♦

Change the time of day to get a look at where the sun rises and sets. It is best to do this before you  ♦
start editing your terrain.
If your water looks strange after you’ve changed the sea level, lightly tap the terrain with one of the  ♦
sculpting tools to re-render the water.
Keep camera-angle issues in mind when building to avoid cameras bouncing up steep terrain walls  ♦
(among other issues).
Keep travel times in mind when placing lots and designing roads.  If you have a lot of houses on  ♦
one end of your world and all of the rabbitholes on the other, it will take Sims a long time to get to 
their jobs.
Put down invisible picnic baskets (which can be found in the BuyDebug menu if you have  ♦ The Sims 
3 World Adventures expansion pack) if you want to see Sims autonomously picnicking there.
Make sure to include some low cost lots so that newly created Sims can afford to live somewhere. ♦

For easier sharing of lots, try to make most of them square shaped, since they can be rotated any  ♦
direction. In cases where this is not possible or desired, try to be consistent about the direction of 
the shorter side of the lot vs. the road and front door.  Players can only really rotate a rectangular 
lot in two directions so consistency multiples the number of places that they can move lots to.
Place lots mostly on flat ground to make sharing lots and moving them around in your world easier. ♦

Front doors should have at least a little outdoor lighting, so be sure to check how your houses look  ♦
at night.
Outdoor trashcans and mailboxes that are closer to the house make taking out garbage and paying  ♦
bills more convenient.

Technical
Keep in mind that rabbitholes and venues that are on the same lot have a single thumbnail,  ♦
address, and map tag.  The only benefits to sharing a single lot is that it saves on overall lot count 
and it allows more visible area to be at high LOD when the camera is nearby (remember that we 
render a limited number of high LOD lots at any given time).
Give as much space around a lot as possible when changing grid and changing elevation. ♦

Mailbox orientation = thumbnail orientation. The location and direction that the mailbox is placed  ♦
on a lot is where the camera takes the automatic picture of that lot to use as the lot thumbnail.
The door closest to the mailbox is considered the front door. The front door is the door that is most  ♦
used by Sims going to and from the house.
Avoid building lots that are on really steep terrain. There is a higher chance of strange seams along  ♦
the edges.
Don’t place world objects on lots because players will not be able to remove them and Sims route  ♦
through them.
Don’t use sidewalks to “paint” patio-type areas (by placing multiple sidewalks next to each other).  ♦
This confuses the routing system.  
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GLOSSARy
Alpha Channel
Where the degree of transparency of all or part of a texture is set.

Chunk or Terrain Chunk
A 256 x 256 area of the terrain. The terrain map is divided into chunks to provide better performance. 
The chunks closest to the camera render in high LOD and the chunks further away render in low LOD.

Height Map
A height map is a 2D image that is used to calculate a 3D surface.

Level of Detail (LOD)
Objects and textures have different visual complexities contained within them. High LOD objects take 
more processing power to render than low LOD objects. To improve performance, objects closer to the 
camera are rendered in high LOD, while objects further away are rendered in low LOD.

Manipulator Handle
The lines or circles that you can grab to move objects around when you select the Move World Object 
or Rotate World Object tools.

Opacity
How solid (vs. see-through) a texture is. This usually refers to the overall texture.

Power of Two (in relation to image size)
The size of the image must be divisible by two and should be one of these numbers: 128, 256, 512, 
1024, 2048, etc.

Rabbithole
A building that Sims go into to do a variety of activities (such as taking classes, going to work, going to 
school, watching a sports game). They can be placed via Build Mode when on a Community Lot.

Spawner
An object placed via The Sims 3 Create a World Tool—Beta or on a Lot (through BuyDebug) that 
creates objects that Sims can collect – such as butterflies, beetles, fish, gems or metal.

World Layer
In The Sims 3 Create a World Tool—Beta, this is the area that you paint, sculpt, and place objects, 
trees, spawners on. In The Sims 3, this is the area between lots.

SPAWNERS AND OBjECTS LISTS
The items in bold face are most likely to spawn.

Fish
Spawner Name Objects Likely to Spawn
Ocean, Common1 Treasure Chest, Anchovy, Jellyfish, Red 

Herring, Blowfish, Salmon, Swordfish
Ocean, Common2 Treasure Chest, Anchovy, Jellyfish, Red 

Herring, Tuna, Tragic Clownfish, Shark, Lobster
Ocean, Uncommon1 Treasure Chest, Alley Catfish, Red Herring, 

Tragic Clownfish, Tuna, Siamese Catfish, 
Shark, Lobster

Ocean, Uncommon2 Treasure Chest, Jellyfish, Red Herring, 
Blowfish, Angelfish, Swordfish

Ocean, Rare Treasure Chest, Red Herring, TragicClownfish, 
Blowfish, Shark, Angelfish

Lake, Common1 Treasure Chest, Minnow, Goldfish, Rainbow 
Trout, Red Herring, Siamese Catfish, Black 
Goldfish

Lake, Common2 Treasure Chest, Minnow, Goldfish, Red 
Herring, Salmon, Angelfish, Lobster

Lake, Uncommon1 Treasure Chest, Goldfish, Rainbow Trout, Red 
Herring, Piranha, Shark, Lobster

Lake, Uncommon2 Treasure Chest, Alley Catfish, Rainbow Trout, 
Red Herring, Salmon, Angelfish

Lake, Rare Treasure Chest, Red Herring, Piranha, Black 
Goldfish, Shark, Angelfish, Vampirefish, 
Lobster

RobotFish Treasure Chest, Red Herring, Black Goldfish, 
VampireFish, RobotFish

DeathFish/Graveyard Treasure Chest, Red Herring, VampireFish
Freshwater Designator Treasure Chest, Minnow, Goldfish, Rainbow 

Trout, Red Herring, Salmon
Saltwater Designator Treasure Chest, Anchovy, Jellyfish, Red Herring, 

Tuna, Salmon, Swordfish,Tragic Clownfish
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Egypt, Oasis, Common Treasure Chest, Frogs, Alley Catfish, Red 

Herring, Siamese Catfish, Crocodile
Egypt, Oasis, Rare Treasure Chest, Frogs, Alley Catfish, Red 

Herring, Siamese Catfish, Crocodile
Egypt, River, Common Treasure Chest, Alley Catfish, Red Herring, 

Siamese Catfish, Salmon, Crocodile
Egypt, River, Rare Treasure Chest, Alley Catfish, Red Herring, 

Siamese Catfish, Salmon, Crocodile, Lobster
Egypt, MummyFish Treasure Chest, MummyFish
China, Common Treasure Chest, Doitsu Koi, Goldfish, Red 

Herring, Kawarimono Koi, Angelfish
China, Uncommon Treasure Chest, Red Herring, KawarimonoKoi, 

Ochiba Koi, Black Goldfish, Angelfish
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China, Rare Treasure Chest, Red Herring, Kawarimono 

Koi, OchibaKoi, Black Goldfish, Tancho Koi, 
DragonFish

China, Koi1 Treasure Chest, Goldfish, Kawarimono Koi, 
Tancho Koi

China, Koi2 Treasure Chest, Doitsu Koi, Ochiba Koi, 
TanchoKoi

China, DragonFish Treasure Chest, TanchoKoi, DragonFish
France, Common1 Treasure Chest, Frogs, Rainbow Trout, Red 

Herring, Snails, Crawfish
France, Common2 Treasure Chest, Frogs, Rainbow Trout, Red 

Herring, Snails, Crawfish
France, Uncommon Treasure Chest, Frogs, Rainbow Trout, Red 

Herring, Snails, Crawfish, Black Goldfish
France, Rare Treasure Chest, Frogs, Red Herring, Snails, 

Crawfish, Black Goldfish
France, FrogPond Treasure Chest, Frogs, Minnow

Insects
Butterflies

Moths Moth
Monarchs Monarch
Butterflies - Low 1 Monarch, Red, Blue
Butterflies - Low 2 Monarch, Gold, Green
Butterflies - Med 1 Gold, Red, Green, Purple
Butterflies - Med 2 Gold, Blue, Silver
Butterflies - High 1 Red, Blue, Green, Purple, Silver, Zebra
Butterflies - High 2 Gold, Red, Purple, Silver, Zebra, Kite
Butterflies - Epic Moth, Monarch, Gold, Red, Blue, Green, Purple, 

Silver, Zebra, Kite
Butterflies - Silver Silver
Butterflies - Zebra Zebra
Butterflies - Kite Kite
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(China) - Dart Dart, Green
(China) - Mix Dart, Bamboo
(Egypt) - Crypt Moth Crypt, Moth
(Egypt) - Cleopatra Cleopatra, Monarch
(Egypt) - Mix Crypt, Cleopatra, Moth, Monarch
(France) - Pasha Pasha, Gold
(France) - Glowy Pasha, Glowy

Beetles
Roaches Cockroach
Ladybugs Lady
Japanese Japanese
Water Water
LightningBugs Light
Rhino Rhino
Stag Japanese, Stag
Spotted Lady, Spotted
Trilobite Water, Trilobite
Rainbow Light, Rainbow
All Lady, Cockroach, Japanese, Water, Light, 

Rhino, Stag, Spotted, Trilobite, Rainbow
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(China) - Assassin Assassin, Water
(France) - Cerambyx Cerambyx, Light

Rocks, Gems, and Metal
Metal

Iron Iron, Silver, Gold
Silver Iron, Silver, Gold
Gold Iron, Silver, Gold
Iron-Silver-Gold Iron, Silver, Gold
Palladium Iron, Silver, Gold, Palladium
Plutonium Silver, Gold, Palladium, Plutonium
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(Egypt) - Copper Silver, Gold, Copper, Mummitomium
(Egypt) - Mummitomium Iron, Copper, Mummitomium
(Egypt) - Mix Low Iron, Silver, Gold, Copper, Mummitomium
(Egypt) - Mix High Gold, Palladium, Copper, Mummitomium
(China) - Platinum Copper, Silver, Platinum
(China) - Mercury Silver, Plutonium, Mercury
(China) - Mix Low Copper, Silver, Gold, Palladium, Mercury, 

Platinum
(China) - Mix High Gold, Plutonium, Mercury, Platinum
(France) - Titanium Titanium
(France) - Iridium Iridium
(France) - Mix Low Silver, Gold, Titanium, Iridium
(France) - Mix High Gold, Palladium, Titanium, Iridium
Compendium Compendium
Supernovium Supernovium
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Rocks
Small Meteorite Space Rock Small
Medium Meteorite Space Rock Medium
Small-Medium Meteorites Space Rock Small, Space Rock Medium
Huge Meteorites Space Rock Small, Space Rock Medium, Space 

Rock Large

Gems
Gems Aqua Aqua
Gems Low 5x Aqua, Emerald, Yellow, Diamond
Gems Low 3x Smoky, Ruby, Yellow, Tanzanite
Gems Med 1 Aqua, Smoky, Diamond,  Rainbow
Gems Med 2 Emerald, Ruby, Yellow, Tanzanite,  Rainbow
Gems High Yellow, Tanzanite, Diamond, Crazy
Gems Epic Ruby, Tanzanite, Diamond,  Pink
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(Egypt) - Alabastar Alabaster, Smoky
(Egypt) - Turquoise Turquoise, Aqua, Tanzanite
(Egypt) - Mix Alabaster, Turquoise, Quartz, Aqua, Smoky, 

Rainbow
(China) - Lapis Lazuli Lazuli, Emerald
(France) - Citrine Amethyst, Citrine, Yellow,  Pink
(France) - Opal Amethyst, Opal
(France) - Mix Amethyst, Citrine, Opal
Quartz Quartz, Diamond,  Rainbow
Tiberium - Low Quartz, Tiberium, Aqua
Tiberium - High Quartz, Tiberium, Tanzanite, Crazy
Soulpeace Soulpeace, Diamond,  Rainbow
Geode Geode, Septarian
Geode + Septarian Geode, Septarian
Septarian Geode, Septarian

Seeds and Plant Commonalities
Common1 High Common, Low 

Uncommon, No Rare
High Spawn Frequency, 
Average Quality

Common2 High Common, Medium 
Uncommon, No Rare

High Spawn Frequency, 
Average+ Quality

Common3 High Common, Low 
Uncommon, Low Rare

Medium Spawn Frequency, 
Good Quality

Common4 High Common, Low 
Uncommon, Low Rare

Low Spawn Frequency, 
Excellent Quality

Uncommon1 Medium Common, Medium 
Uncommon, No Rare

High Spawn Frequency, 
Average Quality

Uncommon2 Low Common, High 
Uncommon, No Rare

Medium Spawn Frequency, 
Good Quality

Uncommon3 No Common, High Uncommon, 
Low Rare

Low Spawn Frequency, 
Excellent Quality

Rare1 Low Common, Medium 
Uncommon, Medium Rare

Medium Spawn Frequency, 
Good Quality

Rare2 No Common, Medium 
Uncommon, Medium Rare

Medium Spawn Frequency, 
Good Quality

Rare3 No Common, Low Uncommon, 
High Rare

Low Spawn Frequency, 
Excellent Quality

Special1 Low Common, Low 
Uncommon, Low Rare, Low 
Special

Medium Spawn Frequency, 
Good Quality

Special2 No Common, Low Uncommon, 
Low Rare, Medium Special

Medium Spawn Frequency, 
Good Quality

Special3 No Common, No Uncommon, 
Low Rare, Medium Special

Low Spawn Frequency, 
Excellent Quality
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China 1 Low Common, High 
Uncommon, Med Rare

High Spawn, Good Quality

China 2 No Common, Med Uncommon, 
Med Rare, Low Special

High Spawn, Excellent Quality

Egypt 1 Low Common, High 
Uncommon, Med Rare

High Spawn, Good Quality

Egypt 2 No Common, Med Uncommon, 
Med Rare, Low Special

High Spawn, Excellent Quality

France 1 High Common, Low Uncommon High Spawn, Good Quality
France 2 Med Common, Med 

Uncommon
High Spawn, Good Quality

France 3 Med Common, Med 
Uncommon, Low Special

High Spawn, Excellent Quality

France 4 Low Common, Med 
Uncommon, Low Rare, Low 
Special

High Spawn, Excellent Quality
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Plant Commonness
Tomato Plant Common
Apple Tree Common
Grape Vine Common
Lettuce Plant Common
Onion Plant Uncommon
Potato Vine Uncommon
Watermelon Vine Uncommon
Lime Tree Uncommon
Bell Pepper Plant Rare
Garlic Plant Rare
Death Flower Bush Special
Money Tree Special
Life Plant Special
Flame Plant Special
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Cherimola Grape Vine Common
Renoit Grape Vine Common
Avornalino Grape Vine Uncommon
Meloire Grape Vine Uncommon
Gralladina Grape Vine Rare
Cranerlet Nuala Grape Vine Rare
Pomegranate Tree Uncommon
Plum Tree Uncommon
Pomelo Tree Rare
Cherry Tree Rare

RECOMMENDED OBjECTS PER LOT TyPE 
Residential Lots

Lot Type Description Objects Recommended 
for Optimal  Functionality

Recommended 
Objects

Residential Undefined Normal residential lot
Bed, Refrigerator, Stove, 
Countertop, Table, Chair, 
Toilet, Shower or tub, 
Sink, Smoke Detector, 
Lights, Wallpaper, 
Flooring, Roof

Mirror, 
Bookshelf, 
Dresser, 
Fun Object 
(TV, Guitar, 
Computer, etc.,)

Residential Townie 
Only (The Sims 3 World 
Adventures)

Residential lot that only 
the townies can live in

Residential Player 
Ownable (The Sims 3 
World Adventures)

Residential lot in a 
vacation destination that 
your Sim can purchase

Venue/Community Lots
Lot Type Description Objects Required for 

Optimal  Functionality
Recommended 

Objects
Art Gallery A place to view art Paintings and Sculptures  N/A
Graveyard Houses the tombstones and 

urns for deceased Sims. 
Mausoleum Rabbithole 
(allows Sims to be 
employed part-time 
as Burial Specialists), 
Urnstone

 N/A

Fishing Spot A place to fish Water  Picnic Tables, 
Outdoor Grill

Beach Where the Community Cook-off 
takes place

Beach Object (Beach 
Umbrella)

Outdoor Grill

Library A place to read books Bookshelve Computer
Gym A place to work out Athletic Object (Weight 

Bench, Treadmill)
 Stereo, 
Television, 
Swimming Pool

Pool A place where Sims can swim Pool N/A
Small Park Where the Community Cook-off 

and the Chess Tournament 
take place. The Small Park 
draws fewer Sims to it than the 
Large Park.

Park Bench, Picnic Table
Outdoor Grill, 
Swing set, Chess 
BoardLarge Park Where the Community Cook-off 

and the Chess Tournament 
take place. The Large Park 
draws more Sims to it than the 
Small Park.

Misc – Visitors This community lot is open-
ended. Sims use whatever 
objects you put there.

None N/A

Misc – No 
Visitors

This community lots is for 
aesthetic reasons – Sims are 
not drawn here.

None N/A
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Base Game Hidden Lot Types
When you enter Edit Town in the game or Edit in Game, you can change the Lot Type (Residential or 
Commercial) and the Lot Sub Type (Gym, Graveyard, etc). The lots below are not accessible when you 
change the Lot Sub Type, you can only set them in The Sims 3 Create a World Tool—Beta.

Day Spa This location is for the Day Spa 
Rabbithole.  The Sims will be 
able to join the Spa Specialist 
or the Receptionist part-time 
jobs

Day Spa Rabbithole N/A

Restaurant This location should contain the 
Bistro which will allow Sims to 
join the Culinary Career

Bistro Rabbithole N/A

Small Shop This is a general location for 
any rabbithole

Any Rabbithole N/A

Big Shop This location is to be used 
when you want to place 
multiple rabbitholes on the 
same lot

Multiple Rabbitholes N/A

Hospital This location is for the Hospital 
and will allow Sims to join the 
Medical Career

Hospital Rabbithole N/A

Theatre This location should contain the 
Theatre.  Sims will be able to 
join the Music career

Theatre Rabbithole N/A

Stadium This community lot is for 
placement of the Stadium.  It 
will allow Sims to join the 
Professional Sports Career 
and hosts concerts and sports 
games

Stadium Rabbithole N/A

City Hall This community lot is for City 
Hall.  It will allow Sims to join 
the Political career.  Sims will 
also hold protests here

City Hall Rabbithole N/A

The Sims 3 World Adventures Lots
These lots are only available if you have The Sims 3 World Adventures installed.

Market Where Sims can purchase 
location-specific items. The 
Large Market draws more Sims 
than the Small Market

Any cash register N/A

Market Small Where Sims can purchase 
location-specific items. The 
Large Market draws more Sims 
to it than the Small Market

Any cash register N/A

Dojo  A place for your Sims to 
practice martial arts

Training Dummy or 
Board Breaker

Workout Bench, 
Treadmill

Nectary Where Sims can go to purchase 
Nectar

Nectary Cash Register Nectar Maker

Chinese 
Garden 

 A lot your Sims can visit to do 
peaceful things.

Meditative items 
(Scholar’s Rocks, 
Telescopes, 
Bookshelves)

Board Breaker

Base Camp The home lot that your Sims 
use when in a vacation 
destination

Tents, cooking items, 
restrooms, Job Board

Beds, fun objects

Landmark 
Tomb

This designation should be 
used for a tomb (that is not a 
rabbithole or venue type) that 
you want other players to easily 
access in your world. It will 
have a Map Tag in the Map 
View mode of the game

Tomb objects (found in 
BuyDebug)

 N/A

Hidden Tomb  This designation should be 
used for a tomb (that is not a 
rabbithole or venue type) that 
you want to remain hidden for 
other players to find.  It will not 
show a Map Tag in the Map 
View mode of the game

Tomb Objects (Found in 
BuyDebug)

 N/A
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